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Introduction 

 
The Job Costing module provides for the maintenance and operation of Jobs, Projects and 
Contracts on the basis of measurable line items of work along with their cost estimates. 
 
Integrated system operations mean that ‘all costs’ can be recorded, in the normal manner, to 
other dataflow ledgers whilst being allocated to a selected part (line) of a Job at the same time. 
The system automatically lodges Job related costs to Work in Progress balances in the Nominal 
ledger. 
 
The term, ‘all costs’, includes outstanding commitments and actual updated costs. The build-
up of these costs and their comparison to estimates are visible through the powerful Job 
enquiry, on a period and cumulative basis. 
 
By providing analysis and drill downs to supporting detail on the entire Job or parts of it, both 
operations and finance staff are presented with information on progress and performance. 
 
The system offers automated procedures for the control of each Job. These procedures can 
vary according to Job ‘TYPE’. Where appropriate, these procedures reflect work in progress, 
revenue recognition and accruals in the financial ledgers on a period by period basis. 
 
Billing/Invoicing routines are also subject to the same efficiencies and controls.  
 
Further automated control stages include Job completion and Job closure. These finalise the 
accounts for the Job, including the production of accruals for outstanding commitments and 
unused estimates. 
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Job Structure and Estimates 

 
The structure of each job is flexible and can be 
organised to suit your particular requirements. 
Work or components can be set out as line items 
of cost that can be linked to phases, stages or 
sections of the Job. This means each Job has a 
logical arrangement to facilitate the allocation and 
monitoring of costs as well as enabling the 
maintenance of structured budgets or estimates for 
the job. 
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When the job is started and costs are registered, the budget/estimate values can be compared 
against these actual costs. When an estimate on a given part of the job is exceeded by one or 
more actual, booked costs i.e. an overspend, the system automatically generates an estimate 
adjustment to match the actual costs and consequently maintain the Job margin correctly. 

At user defined intervals, or milestones, the budget or estimate values can be frozen. 
Consequently, it is possible to compare current costs against earlier versions of the budget. 

New jobs with their structure and budget can be created directly via the keyboard or copied 
from existing jobs (templates). Copying and editing makes the task of creating new jobs quick 
and straightforward and enables even the most complex of jobs to be created with the minimum 
of effort. 

NB. Before creating a Job you should refer to the section on Parameters and Controls for Job 
Costing (see also the table summary). Various references will need to be set up within these 
options so they are available to assign to the header of a new Job. 
 

Job Enquiry 

Job Enquiry (Job review) provides for comparison of job costs against the estimates (budget) 
to assess performance and identify problems with the Job as a whole and parts of it. 

It also provides the basis for carrying out specific Job processes that relate to periodic 
management of the Job. For example:- 
 

 Review and reset margin levels. 
 

 To generate journal postings that reflect Job status in the Nominal Ledger i.e. 
disclosures for Work in progress, Revenue provision, accruals and cost of sales. 
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JOB Parameters and Controls 

 
Before creating the first Job on the system it is mandatory to set up Job types. These will be 
available for assignment to Jobs across all companies. Further parameters also need to be set 
up and these are detailed in sections that follow. 
 

Job Types 

 
Menu Path: Job Costing > Setup> Job Types 
 
Using the command options available on this screen it is possible to define many Job types, 
each identified uniquely by the entry for ‘Job Type’. 
 

 
 
NB. Job Types must be set up before a Job can be created. 

 
The approach taken to Job costing within the organisation may differ depending on the nature 
of each Job itself or maybe all Jobs are treated in the same way. When Job types are set up 
using the procedures below then each Job can be assigned it’s specific type so that it can be 
managed in the appropriate manner. 
 
For purposes of operating and controlling a Job, there are three specific categories of Job, each 
of which requires a separate Job type to be set up. The differences between these are based 
around the settings for valuation type and the need for SSAP9 (long term contracts) compliance. 
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Procedure 

 
Click [Add] to enter the unique label (up to 40 alpha-numeric characters)  
and then complete the remaining properties, depending on which categories (see below) apply 
to your organisation. 
 

Repeat the process if more than one of the Job categories apply or if you want to build 
several Job Types that share the same category. This may be helpful as a 
supplementary identifier when searching the Job records. 

 
NB.  The first entry on the list of Job Types will be used by default on entry of a new Job. 

Use the UP/DOWN sequence buttons to change the order of listed types and set your 
preferred default. 

  
Category 1 – SSAP9 – Percentage Complete Jobs 
 

These are typically contracts that require management over longer periods of 
time and demand specific attention for periodic disclosure of revenue provision 
in relation to WIP. 
 
Settings: 

 
‘Valuation Type’.  WIP 
RRS Journal Posting (SSAP9)  ON 
‘minimum % complete’ – set % as required. 
Warranty accruals – set as required 
 

 
Category 2 – WIP (only) Type Jobs 
 

These jobs will not need to comply with rules for revenue recognition but 
management of them will reflect work in progress, on a cumulative basis, until 
a ‘trigger’ is set either to release the WIP for part of the Job or the entire Job. 
 
Settings: 

 
‘Valuation Type’.  WIP 
RRS Leave blank - ‘min% complete’ – not applicable. 
Warranty accruals – set as required 

 
 
Category 3 - Non WIP Jobs 
 

These are generally smaller projects where no particular management 
processes are required. Costs recorded to these jobs can be coded directly to 
the Profit & Loss accounts and there is no requirement to monitor work in 
progress. 
 
Settings: 

 
‘Valuation Type’.  Non-WIP 
RRS Leave blank - ‘min% complete’ – not applicable. 
Warranty accruals – set as required 

 
 
The following sections outline the procedures to set up further parameters and controls. The 
summary table below shows the priority to be given for their maintenance before creating Jobs 
and starting operations. 
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Summary of Parameters by Job Type 

 
 
Controls 
 

 
JOB TYPE / CATEGORY 

 SSAP9 JOBS WIP JOBS NON WIP JOBS 

 
Document 
Parameters 
 

 
Required 

 
Required 

 
Required 

 
Cost Categories 
 

 
Required 

 
Required 

 
Required 

 

 
Nominal Accounts 
 

 
Required 

 
Required 

 
Not Applicable 

 
Operational Status 
 

 
Recommended 

 
Recommended 

 
Optional 

 
Budget Status 
 

 
Recommended 

 
Optional 

 
Optional 

 
RRS Markdown 

 
Table supplied 

- can be changed 
 

 
N/A 

 
N/A 

 
Analysis Groups 
 

 
Optional 

 
Optional 

 
Optional 

 

 
Intercompany 
Accounts 
 

 
Optional 

 
Optional 

 
Optional 

 
I/company accounts 
for Job 
Consolidation 
 

 
 

Optional 

 
 

Optional 

 
 

Optional 
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Operational Job Costing Parameters 

 

Document Parameters 

 
Settings made here influence the operation of Jobs created in the selected company. Once 
entries have been set click Apply to complete. 
 
If jobs are to be numbered automatically then set the generate Job number box and specify the 
start number alongside. 
 
Similarly the numbering for stage or section line(s) within a JOB may be generated 
automatically. 
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Committing the cost of Works Orders at time they are raised. 
 

Refer section: Operational Parameters for Bill of Materials 
 
1. If required, the commitment value for a Job related WO is registered to it’s Job. The 

commitment cost is derived from the cost value of parts (true stock and non stock) in 
the BOM and the value of all sub assemblies, if the BOM is multi-level. 
 
In addition consider the option:- 
 

Select on Individual order ?  

If set, the choice is given to register the commitment as each Job related WO is 
entered. 
If not set, the commitment cost will be registered for all Works Orders. 

 
2. If this setting is not required, left blank, then a commitment cost is not registered to the 

Job when a WO is raised. 
 
 
Warranty % 

 
This percentage will be applied to the total of Customer Order values specified on the 
Job Lines/sections of a Job. The result will be an accrued cost journal which will be 
automatically generated when a Job is set as Completed. 
 
The Job type (see above) specifies that warranty accruals will apply or not. The 
assignment of Job type will finally determine the requirement for each Job. 
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Budget status 

 
There is no enforcement to use this parameter but it is likely to be a requirement. For the 
purposes of comparing costs to estimates(budgets) set up one or more Budget status levels 
here. They apply to all Jobs in all companies.  
 
As a job progresses the job review screen offers the function to close each stage in the order 
listed here. This freezes the budget for comparison against current actual spend. Closing the 
next stage will reflect any budget changes made since the previous stage and enable current 
actual costs to be compared to the revised status. 
 
NB. The ability to freeze a budget level applies only to a selected Job. These means each 

budget level operates independently for each Job. 
 
Use the command buttons along the bottom of the window to maintain a list of budget 
descriptions (up to 40 characters). Click update to complete entries. 
 
Use the UP/Down sequence buttons to determine the order in which these levels will be closed 
(frozen). 
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Operational Status 

 
The headings specified in this list may be applied to jobs across all companies. The example 
below shows a simple structure of ACTIVE and INACTIVE, but it is possible to set up any 
number of status headings. 
 
The assignment of this status against a JOB can be switched at any time. 
 
The main control offered to any of the headings is the permission to raise Purchase orders. The 
example above would mean Jobs assigned as INACTIVE would not allow any more Purchase 
orders to be recorded against them. 
 
Click ‘ADD’ to specify each Description (up to 40 characters) and set ‘Allow Purchase orders’ 
as required. Then click Update to complete. 
 
Use the Up/Down Slide buttons to set the order of headings in the list. The first heading is used 
as the default assignment when a new Job is created. 
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RRS Markdown 

 
The table of RRS mark down percentages applies only to SSAP9 job categories and is 
specifically used by both the ‘Generate RRS journal’ routines and the Job review screen to 
support the management of these long term Jobs. 
 
The purpose is to acknowledge that when revenue recognition values are computed for each 
Job, based on percentage complete, there will inevitably be costs for the Job that are 
unexpected and therefore cannot be foreseen and estimated. 
 
The further the JOB is from completion, say 30% complete, the more likely there will be 
unexpected costs as the Job progresses to completion. It would be prudent therefore, to adjust 
the basic calculation of Revenue recognition (RRS value) by including a percentage mark down 
that serves only to reduce the RRS value, and therefore avoid overstating revenue in the 
accounts. 
 
These mark down percentages generally reflect the position that the nearer to completion, the 
lower the mark down %. 
 
The table supplied operates across all companies and all SSAP9 Jobs. 
 
If required the table can be edited or additional levels added to reflect operational 
circumstances. 
 
Click ADD to specify a new level in the table. 
 
Select a row in the grid display and click Modify to change the percentage complete and % 
mark down values.  
 
Click Update to complete. 
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Job Costing Analysis Parameters 

 

Cost Category 

 
Each Job will need to reflect a cost structure and these categories are essential to completing 
that structure. Headings listed here will be available to all jobs in all companies. 
 
NB. Cost categories must be specified.  

 
The list may contain an unlimited number of categories, each reflecting your own terms to 
describe the nature of work/activity carried out. The cost category can be generic e.g. 
Materials. The line item of cost specified within a Job structure must be given a cost category 
heading but in addition it has a further free text description which can be more specific in 
nature. 
 
Click ADD to enter the Category description (up to 40 characters) and then click Update to 
complete. 
 
Use the Up/Down Slide buttons to set the order of a selected category in the list. Repeat this 
operation on each heading in turn. 
 
NB. For costs incurred in securing a Job related order (before it starts officially), enter a 

cost category and set the status as Pre-Order. 

Assignment of costs to this category of a Job will be treated outside the scope of the 
Job performance. They are not forced to go through WIP in the balance sheet. The 
Job enquiry screen (Overview Tab) gives an analysis of these pre-order costs to 
enhance the information available. 
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Analysis Groups 

 
Setting up Analysis groups is optional but may prove useful when performing enquiry searches 
(cross job analysis when reporting?) 
 
These analysis headings can be set up at any time and are available to all Jobs in all 
companies. 

 

 
 
First, using the check box options for ‘Groups Required’, determine the number of group levels, 
up to three, you plan to operate. Next, for each level you have checked you may, optionally, 
change it’s default description (e.g. Analysis Group 1) so as to be meaningful to your grouping 
structure. 
  
For each of these groups, you may then enter the headings required. Click the required ‘Group 
Selected’ radio button. Existing headings, if any, are shown in the list box. 
 
To start a new entry, click the Add button. An item ‘new’ is listed and highlighted. Simply type 

the name of your heading to replace the text ‘new’. Items are saved instantly. You should ensure 
each heading name is different and meaningful to operators.  
 
To change or remove a heading from the list box, select (click it) and click Modify or Remove, 

as required. Change a heading by over-typing a new one. 
You cannot remove groups which have been assigned to Jobs. 
 
Use the Up/Down sequence buttons to set the order of a selected analysis heading in the list. 

Repeat this operation on headings at each level to achieve the required order. 
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Control Accounts within Job Costing 

 

Nominal Ledger Control Accounts 

 
The nominal code map is required for the management of SSAP9 and WIP Jobs. Ensure the 
Nominal ledger charts of accounts have been completed to accommodate the automated 
postings generated for Work in Progress, Cost of Sales, Revenue recognition and Accruals. 
 
Non –WIP Jobs are not affected by the nominal code mapping. 
 
Click the Modify button and select each code. Click Update to finish. 
 
Processing rules behind each account are outlined below. 

 

 
 

WIP Balance Sheet 

 
For open Jobs all postings of cost lines, being outstanding commitments and actual costs, are 
forced to this account (typically Debits). 
 
When a Job is completed all related costs are released from here to the Cost of Sales account. 
 
Payment on A/C Balance Sheet 

 
For open Jobs all sales invoice lines are forced to this account. 
 
When a job is completed the related values in this account are released to the Sales account. 
 
RRS Balance Sheet 
RRS Profit & Loss 
WIP Transfer Balance Sheet 
COST Transfer Profit & Loss 

 
These accounts apply to SSAP9 only and provide for the separate disclosure of Revenue 
recognition and associated cost of sales. 

 
RRS journals post to these accounts to reflect the revenue provision and cost of sales (based 
on the balance in WIP) in the profit and loss account. 

 
When a job is completed the related cumulative balances in these accounts are reversed out. 
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When a Nominal Year end process is run the profit or loss is accounted for in the normal 
manner. If the Job is completed in the new year all the job related RRS journals on these 
accounts, from the start of Job, are, again, reversed out. Thus any profit or loss reported in year 
1 is then reversed in year 2 and the final JOB results posted by the transfer of balance sheet 
WIP and ‘Payments on Account’ to the Profit and Loss. 
 
Cost of Sales Profit & Loss 

 
When jobs are completed the value of all related costs held in the WIP account are released to 
here. 
 
Accrued COS Balance Sheet 

 
When a job is completed this account is credited with the:- 
 

value of all unused/outstanding estimates 
and 

value of all open/outstanding orders (Purchase and Works) 
 

After a Job is completed any further job related costs for it are forced to this account and used 
to offset the value of outstanding estimates at completion (as above). For open purchase and 
works orders, their progress to actual costs (supplier invoice and stock nominal update 
respectively) is automatically mapped to this account also. 
 
Where the value of these post completion costs exceed the value of the unused/outstanding 
estimates the difference will be released from this account and charged to the Profit and Loss 
using the late cost accruals routine – refer Job management section. 
 
When a job is closed and the value of unused/outstanding costs exceeds the value of late 
postings the difference, being unused estimates, is debited to this account to provide clearance 
of over provision of charges in the Profit and loss.  
 
 
 
Accrued COS Profit & Loss 

 
When a job is completed this account is debited with the value of:- 
 

 all unused estimates 
 

 all open/outstanding orders (Purchase and Works) 
 

 warranty accruals (contra to ‘Accrued Warranty Balance Sheet) 
 

Refer to the above account ‘Accrued COS Balance sheet’ for contra processing rules. 
  
Sales Profit & Loss 

 
When jobs are completed the value of all related invoices held ‘on account’ are released to this 
account (profit and loss). 
 
Accrued Warranty Balance Sheet 

 
When jobs are completed the warranty value (based on the set percentage applied to the total 
of Sales Order values on all Job Lines) is credited to this account. The contra debit is to the 
Accrued COS Profit and Loss. 
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Operational Parameters outside Job Costing 

 
Depending on operational requirements it is necessary to look at the issues and options 
available for use of the related ledgers. 
 

Nominal Ledger and Cost Centres 

 
Accounting Period End 
 
Automatically generated Job Costing journals operate in accordance with the accounting 
calendar specified for each company. 
 
Chart of Accounts 
 
The account codes mapped out for Job costing (as above) must be assigned to each chart of 
accounts. They should be properly configured to meet the processing and reporting 
requirements of the Nominal Ledger. 
 
Cost Centres 
 
Typically the Profit and Loss accounts may be set for cost centre analysis. Ensure these are 
set under the option ‘Nominals’ on the Cost centre Setup menu. Each Job (see under Job 
Header Maintenance) can be assigned a cost centre profile that will be used automatically by 
the Job management journals (SSAP9 and WIP type jobs). 
 
Posting Controls 
 
Menu Path > Nominal Setup > Nominal Ledger Parameters 

 

 
 

‘Post RRS Margin Journals as part of period end’ 
 
Set this parameter if you wish to automate their production at the same time as the Nominal 
period is closed. 
If not, these journals can be triggered manually from menu options within Job costing – refer 
Job Management processes. 
 
‘Allow posting to Control Accounts’ 
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Also, consider whether control accounts should be available for selection within posting routines 
generally. The term ‘control accounts’ applies to the nominal codes specified for Job costing 
and Sales, Purchase and Stock ledgers. 

 

Purchase Ledger 

 
Menu Path > Purchase Ledger Setup > Default Company Parameters 
 

 
 
 
Set ‘Approved Parameters’ - Percentage and Value. 
 
These parameters apply to all Purchase Orders, including job related orders, and their progress 
to Invoice. They provide tolerances that automatically set the ‘Approved’ status of Supplier 
Invoices raised from Purchase Orders. If the Invoice value exceeds the Order value by either 
the % specified or the Value specified then the Invoice will update to the ledgers as 
‘Unapproved’ and await resolution. 
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Purchase Orders 

 
Menu Path > Purchase Orders Setup > Order Parameters 
 

 
 
Set the parameter ‘Carry forward exchange rate to Deliveries/Invoices’. 
 
If set this will ensure that the exchange rate applied to each Purchase Order will also be applied 
to related Supplier Invoices. This avoids variances in exchange rates distorting the Job costs. 
 
Review the use of the parameters available for Purchase Order operation. 
 
On the header of each Purchase Order and related Supplier Invoices, further separate control 
flags are given to release and approve a document ‘on the fly’ as it were. The ‘Approve’ status 
will carry forward, after invoice update, and restrict payment. The release status controls if an 
Order is allowed to progress.  
 
Notes: 
 

 Purchase Order lines for true stock items cannot be job related. These lines must be 
received to the warehouse by progressing the Purchase order through receipt or Invoice. 
Then, true stock items can be issued out to a Job using the ‘Stock Issues/Returns’ option 
(Stock Ledger Transactions menu) or by stock issues conducted as part of Works Order 
progression. 

 

 Jobs can only be assigned on Purchase Order line entry. Assignment cannot be made, or 
changed, on the Supplier Invoice line that has been generated from an Order line. 
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Stock Control 

 
There are no specific Job related parameters within the Stock Ledger. Stock items, both non-
stock Products and True stock should be set up as required.  
If true stock items are to be issued to Jobs their value can only be assigned using the ‘Stock 
Nominal update’ process. Stock items, the valuation basis and control accounts must be 
configured for compliance. 
 
NB. Purchase Order Lines for true stock items cannot be allocated to Jobs. True stock must be 

received into the Warehouse first and then issued out to a Job. 
 

 

Bill of Materials 

 
The Works order process within the stock ledger provides for assignment to Jobs. Again, 
standard procedures are given to build Kit listings to multiple levels of sub assembly if required.  
 
Typically, the outstanding commitment value for a main assembly or Kit will reflect the value of 
any sub assembly parts lists as well. If the Works Order for the main assembly is allocated to a 
Job it follows that all Works Orders for sub assemblies should NOT be allocated to the Job.   

 

Sales Ledger 

 
Customer accounts should be set up as required. Each Job record incorporates an optional link 
to a Customer account and furthermore an additional reference to End User, also drawn from 
the customer accounts. 

 

Sales Orders 

 
At present there are no relationships between Sales Orders and Job Costing. The maintenance 
of the Job Record itself allows for the direct entry of an Order value against each section or Job 
Line. 
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Job Maintenance 

 
Menu Path: Jobs > Job Costing Control 
 
The Job costing control window provides for entry of new jobs and the modification, removal of 
existing Jobs. The procedures also cover the maintenance of cost and revenue estimates for a 
Job. 

 

A new Job can either be specified by direct entry to all levels of the Job structure or using a 
‘COPY JOB’ option.  This requires entry of the Job Header but then allows the structure to be 
created quickly  by copying all Job lines and related cost lines, including estimate values, from 
an existing Job (template). 
 
To locate an existing Job, standard search & select options are provided via the shortcut menu 
(click right mouse button) or click on a column e.g. Job code, and type search characters as 
required. 

 

 
 
 
The grid display show jobs on the basis of the filter choices given on the Options Tab alongside. 
The default setting is to display all Open Jobs. 
 
To start a new Job click the [Add] button to display the Job Header screen. 
 
Alternatively, locate an existing Job in the grid and click [Modify] or [Remove] as required. Jobs 
can only be removed if all estimates are first set to zero (modify) and there is no transaction 
history. 
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Raising a New Job 

 
Click [Add] to display the Job Header. Entries are required at all three levels of the Job structure. 
 

 Job Header 

 Job Lines (one or more lines to specify Job sections or stages) 

 Cost Lines (one or more lines attached to each Job Line) 
 
1. A job must have at least one Job Line with one cost line attached. Set the Job number and 

description first and then complete the remaining fields on the header screen (see Header 
fields below). Note that entry of a Customer account is optional. A job may be set as specific 
to one customer or left blank (open). 

 
2. Next click on the [Outline & Cost] Tab to start entry of Job Lines. 

The outline to the left shows the header of the job, it’s number and description. 

 

 
 

Highlight the header and click the right mouse button. Use the Copy Job option and 
select the Job (template) to copy from. Click Ok and all Job lines and Cost lines with 
estimate values will be copied to the new Job. The structure can be edited using the 
data-entry procedures that follow. 
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If the copy option is not used then click Add to start a new Job Line. 
 
The line code (can be system generated, if required) and it’s description show in the 
job outline display within job search and selection procedures. The job Line may also 
be a reference point for the Sales Invoicing routines when only that section of the Job 
is to be billed. Alternatively, a sales Invoice can be assigned to the Job Header if it 
relates to the Job as a whole. 
 
Each Job Line maintains an estimate for Sales revenue on the Job and also the value 
of any confirmed orders for the Job. They are used to derive the total revenue estimate 
and order values for the Job as a whole. 
 
An existing Job line, with it’s cost lines, can be copied and then repeated within the 
same job. Highlight the Job Line, right click the mouse to display the shortcut menu and 
select Copy. Then choose Paste. 

 

 
 
 
Complete fields (see Job Line fields below) and then click OK. Repeat for additional 
lines, as required. Press Escape or click Cancel when complete. 
 
Note the option ‘Save Job’. If the structure will take some time to complete use this 
option to save the details entered so far. 
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3. To enter cost lines first highlight a Job line (click it) and then click ADD. 
 
The outline to the left shows the job number, Job Lines and Cost lines. 

 

 
 
 
The cost line number is maintained automatically by the system but the description 
must be entered and is used within job search and selection procedures. Actual or 
outstanding committed costs must always be lodged against a cost line. 
 
The estimates for Non- Labour, Labour and Hours on each cost line are used to derive 
the total cost estimate for the Job as a whole. 

 
Complete the cost line fields (see below) and then click OK to repeat for additional 
lines. 

 
Click Cancel or press Esc to finish entry of cost lines. 
 
Review structure and, if required, enter Job Header notes to the Tab sections available 

Scope 
Applications 
Materials 
Notes (short note) – maintains history. 

 
Click Update to complete the Job record and return to the Job control window. 
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Job Header Fields 

 

 
 
 
Job Number    up to 20 characters – entered or set to generate automatically. 
 
Description   up to 40 characters – must be entered. 
 
Job Type   Default may be changed. 
 
All remaining entries on the Header are optional. 
 
Reference    up to 60 characters   
Manager       select 
Operational Status  default may be changed 
Created Date    
Converted to Order date 
Target Date 
Analysis Tab   select as required. 
 
Cost Centre Tab 
 

For SSAP9 and WIP JOBS the job management journals will use the cost centres 
specified here automatically.  
 

 
Customer account 
Client Reference 
Contact 
End User Account 
Contact 

 



 

Page 28 of 59 

 

Job Line Fields 

 

 
 
Line Code       up to 20 characters – entered or set to generate automatically. 
Description   up to 40 characters – must be entered. 
 
All remaining entries are optional. 
 
Further Description  
Target Date 
Stock Code 

 
Only non-stock product codes may be selected here. If selected, this code will be 
picked up automatically on Sales Invoice/Credit lines that relate to this Job Line. 
 

Sales Estimate 
This value, together with other Line values, is used with cost estimates (see below) to 
determine the estimated Job Margin.  

 
Sales Order value 

Being the value of confirmed orders from customers, it is used to calculate the margin 
(the RRS Margin) that in turn derives the revenue provision each month as the Job 
progresses. The order value is significant for SSAP9 Jobs. 
. 
The influence of estimate and order values is described in the section on Job 
Management – SSAP9 Jobs. 

 
NB.  Entry of Sales Estimate and Order values are replacement values for the existing 

estimate amount. Revisions can also be entered via the Job enquiry screen but, by 
contrast, these are based on entry of the change or movement on the estimate rather 
than a replacement value. 
 

Line notes TAB - optional, enter as required. 
 
Enter a short note (identifier) and extended notes then click Update. A Notes history is 
maintained for the current Job Line showing a time stamp for each new addition. 
Further notes can be added for the Job Line via the Job enquiry option (Detail tab). 
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Cost Line Fields 

 

 
 
Description     up to 20 characters – must be entered. 
Cost Category     must be entered - select as required. 
 
All remaining entries are optional. 
 
Non–Labour    estimate value. 
Labour    estimate value. 
Hours     quantity estimate. 
 

These may not be relevant for WIP only and non-WIP jobs and indeed can be left out 
altogether. However for SSAP9 jobs they are significant, especially the Non –Labour 
and Labour value estimates. 
 
The influence of these estimates is described in the section on Job Management – 
SSAP9 Jobs. 

 
These estimate values may be automatically adjusted as a result of Job postings. When 
the estimated cost on a line is exceeded by one or more postings to it, the system 
automatically adjusts the estimate to match the total of actual costs against it.  

 
NB.  Entry of estimate values will replace entirely the current estimate. 

Revisions can also be entered via the Job enquiry screen but these are, by contrast, 
based on entry of an increase or decrease to the current estimate. 

 
Line Notes TAB - optional, enter as required. 

Enter a short note (identifier) and extended notes then click Update. A Notes history is 
maintained for the current Cost Line showing a time stamp for each new addition. 
Further notes can be added for the Cost Line via the Job enquiry option (Detail tab) 
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Job Notes 

 
Job Header notes are shown under four Tab sections:- 
 

 
 
Scope, Applications and Materials 
 

These represent descriptive content about the job. They can only be changed via the 
Job maintenance routines. Job enquiry provides view only on these notes. 
 

Notes  
Enter a short note (identifier) and extended notes then click Update. A Notes history is 
maintained for the Header Notes showing a time and user stamp for each new addition. 
Further notes can be added at the Header level via the Job enquiry option (Detail Tab). 
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Modify Job Record 

 
Open the Job Costing Control window. 
 
The grid display show jobs on the basis of the filter choices given on the Options Tab alongside. 
The default setting is to display all Open Jobs. 
 
To locate an existing Job, standard search & select options are provided via the shortcut menu 
(click right mouse button) or click on a column e.g. Job code, and type search characters as 
required. 
 
Once located click the [Modify] button to display the Job Header screen. Follow the procedures 
given above, including the ‘COPY’ options, to add further parts to the job structure or revise 
existing details. 

 

Remove Job Record 

 
It is not possible to remove a Job unless it’s history is blank and all estimates are zero. 
 
Locate the Job on the grid and click [Remove]. 
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Operational procedures - Integration 

Assembling Costs 

 
With a job structure in place, allocating a cost or commitment is made straightforward by using 
a procedure that is common to all routines. 
that collect and organise the various elements of Job costs. 
 
Job Costing is fully integrated with the df32 Nominal Ledger. This means that transactions are 
entered once only, and all the ledgers are balanced and reconciled. When a transaction is 
processed in the various df32 modules the choice is offered to allocate it to a job. If it is, then 
details will be registered against the Job and the transaction is posted to the Nominal Ledger 
and source ledgers (Sales, Purchase etc) as required. 
 
Job related costs can be considered under two broad headings, being Actual ‘booked’ costs 
and Open or outstanding commitments. 

 
The sum of "outstanding commitment" and "actual costs" represents the total 
commitment on the job. This can be monitored and compared against the 
estimates/budget on an ongoing basis. 

 
For Open jobs, in the category SSAP9 and WIP, the nominal coding is automatically set to the 

Balance sheet WIP account and cannot be changed. 
NB. The only exception to this is for job related costs lodged against a ‘pre-order’ cost 

category. Pre-order costs can be coded, in accordance with standard procedures, 
typically to the Profit and Loss. 

 
If a Job in these categories has been set as COMPLETED then job related updates to it are 
forced to the Balance Sheet nominal code for accruals.  
 

Thus, a Purchase Order may reflect coding to WIP but if the Job has been marked 
COMPLETED by the time a job related order line is invoiced and fully updated to the 
ledgers, the invoice will automatically be coded to accruals in the Balance sheet. 

 
Job Management journals automatically handle the clearance of Balance sheet accounts and 
any Cost centre analysis, based on the specification for the JOB itself, will be posted at the 
same time – refer Job Management. 
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For non-WIP type jobs the nominal coding is completely open to selection and would normally 
be coded direct to the appropriate Profit & Loss accounts. In these cases the posting requires 
allocation to a Job and to cost centres if required.  
 
Drill down features available within the Job Review screen, for the entire Job or parts of it, show 
full transaction details including the originating ledger. 

 
Typical routines that post Actual costs direct to a Job include: 

 timesheets for labour cost allocation 
 

 Purchase invoices/credits made specifically for the job 
 

 Stock Issues/returns from/to the warehouse 
 

 direct journal entry for disbursements and other costs associated with 
the job. 

 
Routines that post Outstanding committed costs are 

 

 Purchase Orders 
 

 Works Orders for assemblies (BOMs) 
 

Import routines are also capable of processing Job assignments. 
Job fields are available for specification when importing:- 
 

Nominal Journals – standard import option on the Tools menu. 
 
Purchase Ledger Invoices 
 

Either using the standard option on the Tools menu 
or 
the advanced import option on PL Setup menu. 
 

Stock Issues – standard import option. 
 
The following table summarises the classification of costs for each routine and highlights the 
use of the Stock Control Module, if it applies to Job costing operations. 
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Job related posing and Allocation 

 
 

Services and Non Stock Materials 

 

 O/S Committed Costs 
Actual Costs 
 

 
Purchase Order module 

Purchase Order 
Receipt (if used) 
Invoice (awaiting Update) 

Updated PO Invoice 

Purchase Ledger  Manual Invoices/Credits 

Nominal Ledger  
Journals 
Journal Adjustments 

Timesheet  Posted Values 

 

 
 
Stock Related 

 

 O/S Committed Costs 
Actual Costs 
 

Purchase Orders 
& Receipt to Invoice 

N/a 

NB. Lines on a PO for true 
Stock items cannot be Job 
related. 

N/a 

Stock Control  

Stock Issues/ Returns 
 
After running Stock Nominal 
Update process 

Stock Control 
Works Order value 
 

WO Issues value (if used) 
 
After running Stock Nominal 
Update process 

 Works Order value 

WO Complete value 
 
(if issue stage skipped) 
After running Stock Nominal 
Update process 
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Purchase Orders 

 
These become costs only when a line or lines on an order are delivered and the related 
supplier’s invoices are fully updated to the Ledgers. 
 
For open Jobs when a job related invoice is updated to the ledgers, the value of the outstanding 
commitment is reduced by the value of the order line and the Work In Progress is increased by 
the invoice amount, taking account of any over or under spend that arises. 
 
These become actual costs as component stock is issued and the value of these stock 
movements are posted to the Nominal Ledger.  
 
The value of the outstanding commitment is reduced by the value of stock issued and the Work 
In Progress is increased. 
 

 

 

Allocating Actual Costs to a Job 

 
When a line entry for a journal or document is started click the right mouse button to show menu 
options and shortcut keys for Job costing assignment (see screen below).  
 
Where multiple lines of goods or services apply to a document, each line may be assigned to 
a different job or all lines can go against the same job. Whichever case applies, the procedure 

must be performed on each line that is job related. 

 

 
 

 
The example above is of a Purchase Invoice/credit note entry. The same principle applies to 
Nominal Journals, Purchase Orders, Stock Issues and Works Order entry. 
 

Costs must be lodged against the cost line part of the selected Job. Open the Job 
outline with the mouse or use the up/down and right/left direction keys to locate the 
required cost line and click [OK[ to select. 
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Purchase Order Lines for true stock items cannot be allocated to Jobs. True stock must be 
received into the warehouse using Purchase Order progress options and then issued out to a 
Job. 
 
The option ‘Stock Issues/Returns’ on the stock control transaction menu and the options to 
progress a works order both allow assignment of actual stock costs to a Job. However the cost 
is not registered fully against the Job until the process ‘Stock Nominal Update’ is run. Check 
this process is regularly actioned to bring the Job costs up to date. 
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Billing/Invoicing 

 
Options to assign revenue (invoices and credit notes) to a Job are:- 
 
Sales Ledger Document Invoicing 
 
Sales Ledger Manually Raised Invoices/Credits. 
 
The procedure for assignment is the same as for costs, described above. 
 
Revenue is recorded against Jobs when sales documents or transactions are fully updated to 
the ledgers. 
 
SSAP9 and WIP Jobs  
 
Against Open Jobs, related Sales document lines will be automatically coded to the Balance 
Sheet ‘Payment on accounts’.  When a Job is completed the balance held, for that Job, in this 
account will automatically be cleared to the Profit and Loss. Refer Nominal Ledger control 
accounts. 
 
Against completed Jobs, lines will be automatically coded to the Profit and Loss. 
 
Non- WIP Jobs 
 
Assign the line to a non-WIP job as described above. Account coding of Invoice and Credit 
Note lines is open to selection, as per normal entry standards. 

 
Cash Paid   Purchase Ledger  and Cash Receipts – Sales Ledger 

 
The Job enquiry reflects cash values  - based on allocation to job related Invoices. 

 
 
 

 

 
 



 

Page 38 of 59 

 

Job Management 

 
With Job Costing comes the ability to review Work In Progress at any time 

- by Job, Groups of Jobs or All Jobs. Integrated processes keep the position 
up to date at all times. 
 
The status of a Job and access to Job specific control processes is provided 
by the Job Review Screen. It aims to suit the needs of both operational and 
financial users of the system providing many levels of enquiry to support 
the current position and job history. 
 

Journal production routines, across all Jobs, are given on the Transactions 
menu within the Job Costing Ledger. These specifically address provisions 
for revenue recognition on SSAP9 Jobs and also to handle late cost accruals 
on SSAP9 and WIP jobs. 
 
The section that follows gives a general description of the Job review screen, 
regardless of Job Type. Sections that follow take a more detailed look at the 
management processes relevant for each of the three Job categories. 
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JOB REVIEW SCREEN 

 
Menu Path: Job Costing > Ledger >Job Review 
 

Select Job 

 
Firstly, ensure the Job review screen is set for the required company.  
Type the Job number, if known, to display results in all tabbed levels of the window (see below). 
 
Alternatively type search characters into the job number (or leave blank) and click the Extend 
Button alongside to show a grid display of matching (or all) Job numbers. Select a column on 
the grid and type search characters or use the standard search options available on the right 
click shortcut menu, for the selected column. 

 

 
 
Upon Job selection the four Tab sections are populated. 

 
Header Tab – displays the Job Header data. 
 
Scope, Applications and Materials – displays Job notes 
 
Overview Tab  
 

Displays overall job status and supporting data and also provides access to 
management processes for the selected Job. 
 

Detail Tab 
 

Provides for drill down enquiry on the entire Job or selected parts of the Job 
structure and provides for entry of estimate revisions and notes. 
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Enquiry Operations: An Overview 

 
Use of each Tab is supported by a shortcut menu of options. Whilst many of these provide drill 
down to detailed or summary information, others offer routines for managing the period 
accounting, progress to completion and finally, closure of the Job. 
 
Open the shortcut menu by clicking the right mouse button. When opening the shortcut menu 
to display supporting transactions the position of the mouse pointer is significant. 
 
On the Overview Tab it is possible to show listings for selected values by placing the mouse 
pointer over the field (appears bold - see example below), clicking the right mouse button and 
choosing the required option. 
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On the Detail Tab, open the outline of the Job structure and highlight a specific item e.g. a cost 
line, and then right click to choose a shortcut option. 
 
 

 
 
Each option on the shortcut menu, and the context of it is described below.  
 
NB:  Note the fast key combinations (Ctrl+?) available to open or perform the required action. 

 
A REFRESH (Ctrl+F) option is also given on the shortcut menu. This means the enquiry screen 
can be left open and updated simply by choosing this option. This avoids having to close and 
reopen the window. 
 
NB:  If required the content of listings and analyses can be exported to excel, via the standard 

procedures available within dataflow. 
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Overview Tab 

 
This Tab shows analysis of the Job based on the current Nominal accounting 

period. 

 

 
 
 
Top of screen shows analysis of estimates, billings and payments, and the 

accounting period selection. 

 

 
 
Based on the selected accounting period the lower screen section presents 
period and cumulative analyses of actual costs, revenue provisions (if 
applicable), margins and open or outstanding commitments. 

 
 
Also shown are the percentage complete and remaining estimate values. 
 

NB. Pre –order costs shown are not related to Job performance itself. 
They are shown here to enhance the information available. 
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Shortcut Menu options 

 

 
 
The list of options is covered under three headings. 

 
 Transaction information 
 Summary Balance Information 

NB. Standard procedures on the grid displays are given to:- 
 Export data to Excel 
 Organise grid columns to set visibility preferences. 
 Sort and Select functions (open shortcut menu) 

 

 Action or Processes 
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Transaction information 

 
View Detail Transactions  
 
View Open POs/WOs 
 
View Transaction Summary 
 

These options only work for specific values. Click the value or move the mouse 
pointer over it until it appears in BOLD. Click the right mouse button and choose 
the required option. 
 
Note also the Options Tab where the facility is given to set/clear Filters to control 
which types of transactions are listed. Highlight headings and use the chevron (>  
>>) buttons to include or exclude.  
 

 
 
 

 
 
 
 
 
 
 
 
 
View RRS Valuation Detail 
 

Applicable to SSAP9 Jobs only – lists the revenue recognition journals processed 
to date. 
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Summary analyses 

 
View Period Actuals 

 
Displays actual costs for the period selected on the calendar. 
 

 
 
 
View Job History 

 
Displays period and cumulative summary for each accounting period. 
 

View Budget Performance 

 
Summary information for each budget stage/milestone. 

 
View Costs 
 
View Hours 

 
Summary of costs and hours for each ‘cost Line’ of the Job structure, again on the basis 
of the selected budget stage. 
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Action or Process type options 

 
View Job Alerts 

 
This option displays and allows maintenance of alerts that specifically relate to the 
selected Job. 
Refer to the standard procedures for maintenance of Alerts. 

 
View Budget Status 

 
Use the close option to freeze a budget stage. 
Use the open option to release the budget. 
 

 
 
 
Apply RRS Mark Down % 
Change RRS Margin % for current period  
Post RRS Journals for current period  
 

These options apply to SSAP9 Jobs only – refer below for details. 
 
 
Complete Job (available for all Jobs) 
Complete Job Line (option available for WIP jobs only) 
NB.  Use these options with caution as completed status cannot be reversed.  

These actions are described in more detail under the sections on specific Job 
categories – see below. 

 
 
Close Job 

This option only appears for Jobs that have set as completed. 
When closed, a Job will not be available for selection from postings routines. 

 
 
Refresh 

Applicable to all Jobs. Avoids having to close and reopen the enquiry window in order 
to bring values up to date 
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Detail Tab 

 
This Tab provides for enquiry on a selected part of the Job structure. It also offers the facility to 
enter estimate revisions on cost lines and estimate and order values on Job Lines. 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
Using the outline to the left of this Tab, all or a specific part of the Job structure can be 
highlighted for further enquiry. Open the shortcut menu for options available for use in relation 
the highlighted item. 
 
Many options on the shortcut menu are the same as those described for the Overview Tab 
above. 
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View Notes 
 

For the highlighted item in the structure this option will display the notes history and 
allow entry of further notes, as required. 
Enter the short note, extended description and click Update. 

 
A history of job notes is maintained for each item at each level in the Job structure. 

 
View Audit Trail  
 

Displays related postings that have been updated to the Accounts. 
 
Scan Documents 
 

Refer to procedures for attaching scanned documents. 
 
Add Estimates 

 
Highlight either a Job Line or a Cost Line within it and open the ‘Add Estimate’ window 
from the shortcut menu. Enter revisions to the estimate (and Order if applicable) 
together with 
 
Currency Code – default is home currency. 
Date – default today’s date. 
Reference – must be filled – cannot be blank 
Notes – optional enter as required. 
 

NB.  The value of a revision to an estimate or order is based on entry of the change or 

movement on the estimate rather than a replacement value. 
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Job Transaction Menu 

 
Routines on this menu should be used in conjunction with the review processes described 
below for each category of Job. 
 
RRS options automate journal production across all open SSAP9 jobs, maintaining an up to 
date position for WIP, Revenue Recognition, Cost of Sales and Accruals. They can be used at 
any time as the journal values recognise activity since the last RRS update and consequently 
reflect the value of movement in balances only. 
 
Ensure the nominal ledger control accounts for Job costing have been fully specified. 
 

 RRS Gross margin Journals 
 

For the selected Company, click the generate button to produce RRS Journals to 
the current ‘Open’ period end date (ALL open SSAP9 Jobs). 
 

 RRS Gross margin Journals (Last period) 
 

As above but (Last period) produces journals that reflect Job status at the time of 
the last ‘closed’ period end date. 

 
NB. Before using these two RRS options it is recommended that all related Jobs are 

reviewed – refer to the section on SSAP9 Jobs below. 
 

 Late Cost Accrual Journals 
 

For the selected Company, click the generate button to produce journals applicable 
to all SSAP9 Jobs and WIP jobs marked as COMPLETED. (See Below). 

 
Journals are subject to the standard period posting controls and results are maintained in line 
with the progress of accounting periods in the Nominal ledger, up to and including the current 
open period. If Nominal ledger periods have lagged behind, RRS postings can be synchronised 
with Nominal period closedowns to maintain period on period results. 
 
In each case, the batch update window presents a grid of the postings. Click on a grid line and 
review cost centre analysis using the shortcut menu option (right click mouse button). To 
accept, open the Batch Totals Tab alongside and click Update to process. 
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SSAP9 Jobs: Review and Management 

 
The Job review screen, in particular the Overview Tab, provides the basis for assessing a Job’s 
performance. From estimates and the various job related postings the gross margin and 
provisions for revenue can be established. 
 
From the review it is then possible to generate journals, at any time, to reflect the Revenue and 
WIP transfer to cost of sales in line with the company accounting periods. These are called 
RRS Journals. 
 
NB.  RRS journal routines can also be found on the Job Ledger Transaction menu, 

described in the previous section, but these produce journals for all open SSAP9 Jobs.  
 
Further stages for Job completion and closure also generate journals that finalise revenue, 
costs and accruals. 
 
All journals will, for the appropriate nominal codes, attract the cost centre analysis applied on 
the Job Header – refer Job maintenance. 
 
For a selected Job the Job Review screen offers facilities to:- 

 

 Review and apply Margin controls. 
 

 Generate RRS Journals to current ‘Open’ period (Job only). 
 

 Complete Job and generate completion journals 
 

 Close Job and generate closure journals. 
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Review and Margin control 

 
Select an SSAP9 Job on the Job review screen. The Overview tab presents the current status 
of the Job, along with access to history and supporting data (refer enquiry operations above).  
 

The following explains how the RRS value is maintained and then goes through each process 
available to manage the Job over time. 
 
The RRS value is calculated by applying the gross margin% to actual costs to date, to derive 
the revenue provision value and consequently the percentage complete. 
 
The following example is given in support of the formulation:- 
 

Open orders =         5,000  
Actual costs to date =      40,000 
 
Total estimates (from all Cost Lines) = 160,000 
 
Confirmed orders (from all Job Lines) = 300,000 
 
Margin value = 140,000 (300,000 less 160,000) 
 
Gross margin % = 140,000 x 100   = 46.67%  

300,000 
 
With a margin of 46.47% then it follows ... 

£40,000 costs represents 53.33% of estimated revenue,  
 

therefore  
 
RRS value is  40,000  = approx. 75,000  
   53.33 *100 
therefore, 

 
% Complete=  RRS Value (excl. Markdown) x 100 

 Total Sales Order Value 
 

In the example above the Job is 25% complete. 
 
If the Sales Order value is zero, the percentage complete is based on actual costs as a 
proportion of Estimated costs. 
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Two options on the shortcut menu influence the RRS value. 

 

Apply RRS Mark Down % 

 
To view the adjusted RRS value, select this option from the shortcut menu. Repeat the selection 
to turn off markdown results. 
 
NB.  The actual process of generating the RRS journals will always use the appropriate 

markdown percentage so it is important to set them according to requirements. 
 
The markdown percentages (refer table on the setup menu) operate according to the 
percentage complete. As supplied, the example above would attract an 8% markdown. The 
result would be a lower RRS provision and reflect a degree of prudence. 
 
RRS value     40,000    = approx 65,220 
     0.5333 + 0.08 
 

Change RRS Margin % for current period  

 
The calculated Gross margin percentage can be overridden using this option. 
 
Before doing so you may wish to remove the markdown percent. 
 
A lower margin% will result in a lower RRS value and a lower percentage complete. The 
opposite if the margin % is increased. 
 
The new margin % will be applied to all future RRS journal postings (with markdown % 
included). 
 
If the margin% is lowered to the extent that the new calculation of RRS value falls below the 
total of RRS postings already updated, the new journals will post the required adjustment to 
reduce the previously overstated provision for revenue. 
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Post RRS Journals for current period  

 
For the selected Job, select this option to bring Revenue provisions and WIP transfer to Cost 
of Sales up to date in the accounts. 
 
The accounting entries are described in the section on Control Accounts within Job Costing – 
Nominal ledger accounts. 
 
This option can be used at any time as the journal values recognise activity since the last RRS 
update and consequently reflect the value of movement in balances only. 
 
RRS journals are subject to the standard period posting controls and results are maintained in 
line with the progress of accounting periods in the Nominal ledger, up to and including the 
current open period. If Nominal ledger periods have lagged behind, RRS postings can be 
synchronised with Nominal period closedowns to maintain period on period results. 

 

The batch update window presents a grid of the postings. Click on a grid line and review cost 
centre analysis using the shortcut menu option (right click mouse button). To accept, open the 
Batch Totals Tab alongside and click Update to process. 
 
 

Complete Job 

 
This option is available from the shortcut menu of the Job Review screen 

 
NB.  Use with caution as completed status cannot be reversed.  

 
NB.  A Job cannot be set as ‘Completed’ whilst there are costs pending update.  

 
Check the Purchase Order Invoices and update any outstanding invoices to the 
ledgers. 
 
Similarly for Works Orders where stock has been issued, the process needs to be 
completed by running the stock nominal Update routine on the Stock Ledger 
Transactions menu. 

 
Completion does not close off a Job entirely as postings can still be lodged against it, but coded 
to accruals rather than WIP. Selecting ‘Complete’ opens the completion journal window which 
reflects the following:- 
 

 The total of job related Sales Invoices are transferred from the Balance Sheet 
‘payments on account’ to the Profit and Loss sales account. 

 

 The total value of all related RRS postings, since the start of the Job, are reversed. 
 

 The Job related balance held in the WIP Balance sheet account is transferred to the 
Cost of Sales account. 

 

 The value of remaining estimates, open orders (purchase and works orders) and, if 
applicable, warranty costs are also accounted for as accruals. 

 
Refer to the section on Nominal Ledger Control accounts for more detail on the account 
postings. 

 
Click on a journal grid line and review cost centre analysis using the shortcut menu option (right 
click mouse button). To accept, open the Batch Totals Tab alongside and click Update to 
process. 
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Late Cost Accruals 

 
This option can only be run, manually, from the Job Ledger transactions menu. 
 
Click ‘Generate’ to produce the journal batch update window. 
 
Late cost accrual journals are only generated for SSAP9 and WIP jobs that have been 
completed and where late costs have exceeded Job accruals accounted for by the completion 
journals. 
 
Example 

Completion journals have accrued in total 5,000.00 
A job related supplier invoice is updated to the ledgers to the value of 5,025.10 and has 
been forced to the accruals Balance sheet account. 
 
The late cost accrual journal will process the difference only, resulting in a charge of 
25.10 to the profit and loss account. 

 
Where this process has not been run from the menu option the closure of a Nominal ledger 
period will automatically pick up any outstanding late costs dated on or before the period end 
date. 
  
Click on a journal grid line and review cost centre analysis using the shortcut menu option (right 
click mouse button). To accept, open the Batch Totals Tab alongside and click Update to 
process. 

 

Close Job 

 
This option only appears on the shortcut menu once a Job has been set as 

completed. 
 
All open related Purchase Orders and Works orders must be fully updated 
before a Job can be closed. 
 
When closed, a Job will not be available for selection from postings routines. 
 
Journals will be generated automatically to reverse the value of outstanding 

or unused estimates accounted for by completion journals. 
 
Click on a journal grid line and review cost centre analysis using the shortcut 
menu option (right click mouse button). To accept, open the Batch Totals 
Tab alongside and click Update to process. 
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WIP only Jobs : Review and Management 

 
Facilities to review a Job are the same as those described for SSAP9 Jobs above, but the major 
differences are :- 
 

 Revenue recognition (RRS) and related options to control the Job margin do not apply. 
 

 A ‘Complete Line’ function, available from the Detail Tab, produces completion journals for 
a selected Job Line only. 

 
The Overview tab shows the progress of outstanding commitments and actual costs. Costs and 
revenue lodged against open jobs are coded to the nominal accounts for WIP and ‘Payments 
on account’ respectively. 
 
Job completion and Job Close options generate journals that release balances to the profit and 
loss and post accruals. 
 
All journals will, for the appropriate nominal codes, attract the cost centre analysis applied on 
the Job Header – refer Job maintenance. 
 
For a selected Job the Job Review screen offers facilities to:- 

 

 Review the Job 

 Complete Job Line – Detail Tab only. 

 Complete Job and generate completion journals 

 Close Job and generate closure journals. 
 
To process late cost accruals, manually, use the option on the Job Transactions menu. 
 

Complete Job Line 

 
This option is only available from the Detail Tab and operates on a selected Job Line. 
 
The Job as a whole will be completed either by selecting the Complete Job option or when the 
last open Job line is completed. 

 
NB.  Use with caution as completed status cannot be reversed.  

 
NB.  A Job Line cannot be set as ‘Completed’ whilst there are costs pending update.  

 
Check the Purchase Order Invoices and update any outstanding invoices to the 
ledgers. 
 
Similarly for Works Orders where stock has been issued, the process needs to be 
completed by running the stock nominal Update routine on the Stock Ledger 
Transactions menu. 

Completing a line does not close it off entirely as postings can still be lodged against it, but 
coded to accruals rather than WIP. Selecting ‘Complete line’ opens the completion journal 
window which reflects the following:- 
 

 For the selected Job Line the total of job related Sales Invoices are transferred from 
the Balance Sheet ‘payments on account’ to the Profit and Loss sales account. 

 

 For the selected Job Line and related cost lines, the related balance held in the WIP 
Balance sheet account is transferred to the Cost of Sales account. 
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 For the selected Job Line and related cost lines, the value of remaining estimates, open 
orders (purchase and works orders) and, if applicable, warranty costs are accounted 
for as accruals. 

 
Refer to the section on Nominal Ledger Control accounts for more detail on the account 
postings. 

 
Click on a journal grid line and review cost centre analysis using the shortcut menu option (right 
click mouse button). To accept, open the Batch Totals Tab alongside and click Update to 
process. 

 

Complete Job 

 
This option is available from the shortcut menu of the Job Review screen 

 
NB.  Use with caution as completed status cannot be reversed.  
 
NB.  A Job cannot be set as ‘Completed’ whilst there are costs pending update.  

 
Check the Purchase Order Invoices and update any outstanding invoices to the 
ledgers. 
 
Similarly for Works Orders where stock has been issued, the process needs to be 
completed by running the stock nominal Update routine on the Stock Ledger 
Transactions menu. 

 
Completion does not close off a Job entirely as postings can still be lodged against it, but coded 
to accruals rather than WIP. Selecting ‘Complete’ opens the completion journal window which 
reflects the following:- 
 

 For all open Job Lines the total of job related Sales Invoices are transferred from the 
Balance Sheet ‘payments on account’ to the Profit and Loss sales account. 

 

 For all open Job Lines and their cost lines, the related balance held in the WIP Balance 
sheet account is transferred to the Cost of Sales account. 

 

 For all open Job Lines and their cost lines, the value of remaining estimates, open 
orders (purchase and works orders) and, if applicable, warranty costs are accounted 
for as accruals. 

 
Refer to the section on Nominal Ledger Control accounts for more detail on the account 
postings. 

 
Click on a journal grid line and review cost centre analysis using the shortcut menu option (right 
click mouse button). To accept, open the Batch Totals Tab alongside and click Update to 
process. 
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Late Cost Accruals 

 
This option can only be run, manually, from the Job Ledger transactions menu. 
 
Click ‘Generate’ to produce the journal batch update window. 
 
Late cost accrual journals are only generated for SSAP9 and WIP jobs that have been 
completed and where late costs have exceeded Job accruals accounted for by the completion 
journals. 
 
Example 

Completion journals have accrued in total 5,000.00 
A job related supplier invoice is updated to the ledgers to the value of 5,025.10 and has 
been forced to the accruals Balance sheet account. 
 
The late cost accrual journal will process the difference only, resulting in a charge of 
25.10 to the profit and loss account. 

 
Where this process has not been run from the menu option the closure of a Nominal ledger 
period will automatically pick up any outstanding late costs dated on or before the period end 
date. 
  
Click on a journal grid line and review cost centre analysis using the shortcut menu option (right 
click mouse button). To accept, open the Batch Totals Tab alongside and click Update to 
process. 
 

Close Job 

 
This option only appears on the shortcut menu once a WIP Job has been set as fully completed 
i.e. all Job Lines have been completed.  
 
All open related Purchase Orders and Works orders must be fully updated before a Job can be 
closed. 
 
When closed, a Job will not be available for selection from postings routines. 
 

Journals will be generated automatically to reverse the value of outstanding or unused 
estimates accounted for by completion journals. 
 
Click on a journal grid line and review cost centre analysis using the shortcut menu option (right 
click mouse button). To accept, open the Batch Totals Tab alongside and click Update to 
process. 

NON WIP Specific Processes 

 
Postings to these Jobs are not subject to RRS or WIP processing. 
There are no automated journals produced. 
 
The Overview tab shows the progress of outstanding commitments and actual costs. 
 

Close Job 

 
The only process applicable is ‘Close’ Job. To allow close, open Purchase Orders and Works 
Oders must be progressed to the stage where values are updated to the nominal ledger. 
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Reporting 

 
An extensive range of reports that are mainly self-explanatory. 

 

 WIP Reconciliation Report 
 

 Accruals Reconciliation Report 
 

 
 
 
When the job is marked for completion the accruals are posted for Purchase Orders and 
Remaining estimates split by Labour and non-labour.  
 
After the completion: 
 
Un-accrued estimate:  If you increase the estimate manually or by raising a PO that exceeds 
the outstanding estimate.  
 
Un-accrued Actual cost:  if you post a manual P-INV or stock issues including WO/ Journals/ 
Timesheet posting that exceeds the outstanding estimate that has already been accrued. 
 
Period Balance in Job Costing: It is the outstanding balance of the costs that have been 
accrued for. 
 
Job Costing: Is the total of the first 3 columns. 
 
Awaiting Update: Is the PO invoices waiting to be updated onto the ledgers.  
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 Gross Margin Report 
 

 
Only includes completed jobs that the gross margin has changed from previous period. 
 

 

 Job Summery Report 
 

 Job Summery Cost Report 
 

 Transactions Details Report 
 

 Review Additional Estimate Report 
 

 Sales to Accrue Report 
 

 Job Total by Nominal Report 


